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Hello NCKCN internet members  
 
The summer season has finally arrived! June is the perfect time to take that long 
awaited family vacation and to spend more time outdoors. This month's eNewsletter 
gives you ideas on recreational destinations along with map resources to help get 
you there. Travel safely, do some hiking and biking, and build some lasting 
memories with your family this month.  
 
The goal of each of our monthly eNewsletters is to keep our subscribers informed 
regarding their Internet connection and to improve their Internet experience. To 
meet this goal, each monthly newsletter will usually contain information related to:  

1.  Warnings on a recent virus or e-mail hoax that may affect you 
2.  An update on new services and other local interests 
3.  An answer to a frequently asked Internet related question 
4.  Some fun, seasonal websites to check out 
5.  A short, step-by-step tutorial on an e-mail or browser related task 

We think you'll find the information contained in this newsletter to be a valuable 
tool for enhancing your Internet experience. If, however, you'd prefer not to receive 
these bulletins on a monthly basis, click HERE.  
 
To see what's inside this issue, take a look at the index to the left and thanks for 
reading!  
 
- The NCKCN Team 

SP2 Automatically Downloaded - Important Info For Windows XP Users 

Many Windows XP users have noticed the recent inability to see graphics within incoming e-mail messages. That's because 
Microsoft has now made its Windows XP Service Pack 2 (SP2) a "required critical update" for all people using Windows XP. One 
of the "features" of the SP2 software is that it blocks images from being displayed within incoming e-mail messages. (See below for 
information on changing your settings to allow images to reappear within e-mail messages.)  
 
More About Microsoft's Recent Automatic SP2 Update  
 
As of April 12, 2005, anyone using the Windows XP operating system that had not previously downloaded SP2 onto their computer 
was forced to do so. This was accomplished through Windows XP's Automatic Update feature which is "turned on" as a default 
setting on all Windows XP systems. Thus, it's highly probable that if you use Windows XP, SP2 has been downloaded onto your 
machine whether you've requested it or not. Once this download occurs, however, users must then install the software to activate it. 
For installation instructions, see: http://www.microsoft.com/technet/prodtechnol/winxppro/maintain/sp2aumng.mspx  
 
Why SP2 For Windows XP Operating Systems?  
 
Microsoft's Windows XP Service Pack 2 is a security software update for Microsoft's popular Windows XP operating system. 
Costing almost one billion dollars to develop, this free and huge (200 megabyte) software download promises to make users of 
Windows XP much safer from cyberattacks. SP2 adds protection by closing entries to viruses, increasing spyware barriers, and 
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improving the safeguards of users' personal data.  
 
SP2 Does Not Replace The Need For Third-Party Virus Protection  
 
Windows XP Service Pack 2 DOES NOT REPLACE the need for third-party a) Virus Protection, b) E-mail Filtering, or c) Firewall 
Protection. If you use third party anti-virus software programs from companies like Symantec and McAfee, for instance, you'll still 
need to continue to regularly update your software and scan e-mail attachments for viruses as you've done in the past. SP2 does not 
include robust protection in these three areas.  
 
So Why Am I Unable To See Graphics Within Incoming E-mail Messages?  
 
One of the protective features added to Outlook Express for those Windows XP users who have installed Service Pack 2 (SP2) is 
the blocking of images being displayed within incoming e-mail messages. However, it's not nearly as much fun to receive an e-mail 
message from a friend or source you trust unless you can also view the message's graphics and images. Microsoft provides an easy 
option to allow images to appear within messages, either on a per e-mail basis or for all e-mail messages. To see the graphics within 
messages on an e-mail-by-e-mail basis, with your Preview Pane open, do the following:  

1.  Click your cursor arrow on the gray bar located just below the subject line of the message. It will say, "Some pictures have 
been blocked to help prevent the sender from identifying your computer. Click here to download pictures." If you click 
anywhere on that gray bar, the pictures for that particular e-mail will appear for as long as you have that e-mail open.  
 

2.  If you go to a different e-mail and then come back to this message, you will need to click on that bar again to see the images 
within the message. 

Note: If you don't see the gray bar, open the message in its own window and follow steps one and two above. Otherwise, click your 
cursor arrow on the "View" menu and drop down to "Layout." When the "Window Layout Properties" window appears, make sure 
"Show preview pane header" is checked.  
 
If you want to be able to see all pictures on all incoming e-mail messages that contain images, you can disable this blocking feature. 
Here’s how:  

1.  Go to the Outlook Express "Tools" menu and drop down to "Options."  
 

2.  When the "Options" window appears, click on the "Security" tab. About half way down the window, you'll see an item titled 
"Download images." You will see a checkbox next to the words "Block images and other external content in HTML e-
mail." If you uncheck this box, it will allow images to be viewed again just like before your SP2 update.  
 

3.  Click "Apply" and then "OK" to save your new settings and close the window. 

Note: If you do not have the Automatic Update feature activated on your system and would like to do so, go to this link for step-by-
step assistance: http://www.microsoft.com/athome/security/protect/windowsxp/updates.mspx. If you use Windows XP and are not 
sure whether SP2 has been downloaded and installed onto your computer, go to this link for more information: http://

windowsupdate.microsoft.com. 

Back to Top 

Ask The Help Desk - When Was A Web Page Last Updated? 
 

Question: Sometimes it's important to know how current the information is on a web page. Is there a way to find out when a web 
page was last updated? 
 
Answer: Yes, this can be especially important if you are visiting news-related web pages, stock market sites, or other time sensitive 
websites.  
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A simple method of finding out when a page was last updated is to go to the page in question and then type (or copy and paste) the 
phrase below into the address bar replacing the site's web address:  
 

 javascript:alert(document.lastModified) 
 
A box will appear telling you the date and time of the last update. This trick doesn't work on all websites and will only work if your 
browser is java-enabled (which it probably is). However, in most cases this technique will provide helpful results. Head to a couple 
of your favorite web pages and give it a try!

Back to Top 

Great Sites To Check Out This Month 
 

Locate Recreational Opportunities Before Next Vacation  
http://recreation.gov/ -  If you are planning a vacation this summer and want to check out some of our nation's great recreational 
opportunities, the federal government provides this in-depth informational site to get you started. Recreation.gov allows you to 
search for recreational areas by state, by recreational activity, by agency, or even by map. Have a great trip! 
 
Google Now Offers Map Images Taken Via Satellite  
http://maps.google.com/ -  You've probably used MapQuest.com for map information or driving directions. Now Google.com has 
gone one step further. It offers maps and driving directions but also provides actual satellite images of addresses you input. Simply 
go to maps.google.com, type in your Uncle Bob's home address in Toledo, click on the "Satellite" link toward the top right corner 
of the page, use the zoom feature on the left side of the page, and then check out his house! 
 
Get Involved In A Kitten War  
http://kittenwar.com/ -  No, this is not a site showing cat fights. It's a site filled with images of cute kittens where you vote on your 
favorite feline. Hundreds of pictures of kittens have been submitted. Check out the photo list of the top ten "winningest kittens," the 
ten "losingest kittens," and the ten most recently submitted entries. Upload your own favorite kitten photo and let the voting battle 
begin! 
 
Herbie: Fully Loaded Movie Released This Month  
http://disney.go.com/disneypictures/herbie/ -  This month Walt Disney Pictures presents the fifth feature film in the Herbie series 
that started with the popular movie, The Love Bug, back in 1969. This time the adventurous Herbie takes on the world of NASCAR! 
The film stars Lindsay Lohan, Matt Dillon, Michael Keaton, and Justin Long. Dale Earnhardt, Jr. even makes an appearance. 
Herbie: Fully Loaded is rated G for general audiences. 
 
LPGA's Open Hosted By Colorado  
http://LPGA.com -  This month marks the 60th anniversary of the longest running event currently on the Ladies Professional Golf 
Association Tour. The U.S. Women's Open will be held June 23-26 at Cherry Hills Country Club in Cherry Hills Village, Colorado. 
In last year's exciting event, eventual champion Meg Mallon held off Annika Sorenstam by two strokes. Both will be competing 
this year for their share of the event's $3.1 million purse. Check out this site for the latest news and stats concerning the LPGA. 

Back to Top  

Short Tutorial - Locating Hard-To-Find E-mail Messages 

Have you ever tried to find an e-mail message in your inbox folder that was sent to you months ago but you can't recall the name or 
e-mail address of the sender? Plus, your search for key words that were possibly included in the subject line of the message hasn't 
given you successful results. Well, don't despair. You can also search for key words within the actual message pane windows of e-
mail messages located in your inbox folder (and your other folders as well). Depending on how many messages are stored in your 
inbox and how specific your key word search is, there's a good chance of quickly finding the exact message that you're looking for. 
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See the step-by-step tutorials below.  
 
Outlook Express 6.0 and Windows XP  

1.  With Outlook Express open, click your cursor arrow on your "Inbox."  
 

2.  Click on the "File" menu, drop down to "Find," and then select "Message" from the submenu. The "Find Message" dialog 
box will now appear.  
 

3.  Where it reads "Look In," the location should say "Inbox." Make sure the box is checked beside "Include subfolders."  
 

4.  Look for the field marked "Message" and type your keyword(s) into it. Those words will be searched for in the body of your 
message. Remember, the more words you put into that field, the narrower your search will be.  
 

5.  Click the "Find Now" button. The results will be shown in a frame at the bottom of the window. 

Mozilla's Thunderbird 1.0 on Windows XP: 

1.  With Thunderbird open, click your cursor arrow on your "Inbox."  
 

2.  Click on the "Edit" menu and drop down to "Find." Select "Search Messages" from the resulting submenu. The "Search 
Messages" window will appear.  
 

3.  Make sure it says "Search for messages in: Inbox on Local Folders" and that "Search Subfolders" is checked.  
 

4.  Select "Match any of the following."  
 

5.  Locate the pane that includes three fields. One will be called "Subject," one will be called "contains," and the third field will 
be blank. Click on the word "Subject" and a drop down menu will appear with other options. Select "Body" from this list. 
Leave the field that says "contains" as it is. In the blank field, type in your keyword(s). Remember, the more words you put 
into the field, the narrower your search will be.  
 

6.  Click the "Search" button and the results will appear in the lower pane of the window. 

Mail.app 1.3.9 on Macintosh OS X  

1.  In the search field on your Mail.app tool bar, click on the letter Q with the downward pointing triangle next to it.  
 

2.  A drop-down menu will appear with a number of options listed for either the mailbox you are currently in or for all 
mailboxes. Select "Entire Message" and type in your keyword(s).  
 

3.  A list of messages that include the keyword(s) you typed will appear in the message list.

Back to Top

We hope you found this newsletter to be informative. It's our way of keeping you posted on the happenings at our shop. If, 
however, you'd prefer not to receive these bulletins on a monthly basis, click HERE.  
 
Thanks for your business!  
 
Thank You, 
 
The Staff at NCKCN 
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NCKCN.COM 
 

  
 

 
 
NCKCN - North Central Kansas Community Network 
109 North Mill 
Beloit, KS 67420  
 
785-738-2218 

 
 
(We have used our best efforts in collecting and preparing the information published herein. However, we do not assume, 
and hereby disclaim, any and all liability for any loss or damage caused by errors or omissions, whether such errors or 
omissions resulted from negligence, accident, or other causes.) 

©2005 Cornerstone Publishing Group Inc.  
 
Trademarks: All brand names and product names used in this eNewsletter are trade names, service marks, trademarks or registered 
trademarks of their respective owners. 
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